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OVERVIEW

SYSTEM REQUIREMENTS

You will need Windows 95 or higher and Access 97 or higher to run the MIS. Your computer should have at least 32K of RAM and a mouse. The capacity of the MIS is limited only by the capacity of your own hard disk and back-up device.

The MIS is viewed best when the screen resolution is set to 800 by 600 pixels. 

Summary of MIS Components and Uses

The Juvenile Drug Court Management Information System 2002 (MIS 2002) is a simple, menu-driven Microsoft Access database developed primarily for use by small drug courts. An on-screen form with multiple pages mimics those typically used to record information on drug court clients from intake through to their termination or graduation.  Paper forms are also attached (and included on the compact disk), giving you the option of entering data directly into the MIS from the start or capturing information on paper forms and entering it into the MIS at a later date.

The MIS contains nine built-in reports to summarize and print case file information. Three of the reports produce caseload statistics, three provide lists of current participants, and three provide summaries of individual progress:

· The Caseload Statistics report produces statistics for a period of time specified by the user (a certain week, month, quarter, etc.), including the number of juveniles enrolled, the number of juveniles promoted to phase two and phase three, the number of juveniles in each phase, referrals, assessments and admission to drug court, drug testing, the number of juveniles in each type of treatment, and discharge status.

· The Snapshot Report presents a “snapshot” view of the status of all current cases at the time of printing. Statistics include the number of juveniles in each phase, the number of juveniles who are active-in the program, active-in custody, or on bench warrant status, and the number of juveniles enrolled in each type of treatment (12-step, aftercare, etc.). 

· For those drug courts that receive funding from the Drug Courts Program Office, U.S. Department of Justice, the DCPO Report produces case statistics (ex., number of admissions, graduations, terminations, withdrawals, and deaths; ethnic descent of those admitted) required for the DCPO bi-annual survey.

· Lists of current participants are available in two formats: a contact list of participants in alphabetical order, and a list of participants in treatment grouped by treatment providers. The Participant Contact List includes the admission date and case number, “primary guardian” address and telephone numbers, and “other guardian address” and telephone numbers. The Treatment Contact Sheets (there are two reports - one lists all juveniles in treatment, and one lists all juveniles scheduled to appear on a court date specified by the user) include a treatment provider name, branch, contact person and phone number; juvenile names, admission dates to drug treatment court, and current phases; primary guardian names and phone numbers; and a space for handwritten notes. 

· The Individual Progress Report presents information on a participant’s current status, outcomes of each drug treatment court date, and drug test results. 

· The Status Report for Court summarizes progress made by an individual since his or her last court appearance (compliance with contract, progress notes), and lists current treatment and/or programs, number of positive drug tests in each phase, and specific recommendations to the court.

· The Progress and Compliance Reports are a series of reports that list, for the category you choose, all recorded notes and comments on that topic. The categories include: telephone contacts, drug tests, office visits (no drug tests), home visits, contact with treatment providers, contact with schools, contact with juvenile hall or jail, contact with employers, “other” contacts, case notes, and all contacts and notes. You can print, for example, a summary of all urinalysis results for one individual.
KNOWLEDGE REQUIREMENTS

Familiarity with Access is needed to enter data, move among fields, print reports, make back-ups, etc. An intermediate knowledge of Access is needed to make routine changes to fields, menus, etc.  Expertise in Access is required to make major changes such as altering reports or queries, or creating new reports.

Access to the MIS may be controlled by the database administrator, who should also make or approve all changes to the system.

Expertise Needed to Use the MIS 2002
Every person using the MIS, whether entering data, viewing case records, or printing reports, should have a rudimentary knowledge of Microsoft Access, the database program underlying the MIS. All the standard Access functions, such as deleting records, using filters, and finding records, work in this database, and incorrectly using Access may lead to problems with the MIS 2002.

We assume that a particular person in your court (the court's database administrator, drug court coordinator, etc.) will be in charge of the MIS.  This database administrator controls access to the MIS through passwords and/or the designation of workgroups that limit user access to specific information and protect the structure of the database.  Simple changes, such as adding another option to a drop-down menu or adding a field to a form, are relatively easy to make and instructions for doing so have been included in this guide.  Please note, however, that changes made in fields that are tied to the built-in reports may result in these reports being inaccurate.  These fields are listed under the description of each report in this manual.

Expertise in Access is needed to customize the built-in reporting functions, generate new or different reports, incorporate new queries, or produce caseload graphics.  Instructions for these types of advanced programming are beyond the scope of this guide, but may be found in a detailed Access manual.

“Dear Drug Court Coordinator” 

The first decisions that need to be made before beginning to use the MIS concern how the database will be used, how data will be entered, and what modifications, if any, should be made to the MIS. For example, your court may want to use the entire MIS and enter information in “real-time,” as intakes are performed, contacts are made with participants, etc., using the entire MIS. Or, you may want to use pieces of the MIS, leaving out particular sections (treatment history, for example), and enter only needed data on a weekly basis. It is highly likely that customizing drop-down menus and specific fields will be needed to fit your drug court’s population and procedures. One person, or a few experienced staff, should enter a few cases and test the MIS vis-à-vis the court’s case management and information needs.

Once these initial decisions are made, we recommend that one person – the court’s database administrator, drug court coordinator, or other designated person (if your drug court is very small, these may all be one person, you) – be charged with the responsibility of maintaining the MIS’ security, customizing the MIS as desired, and training and monitoring all staff using the MIS. This person should be familiar with Microsoft Access and the MIS, and make all modifications (or as many as possible) before data are entered. All users not familiar with Microsoft Access or your court’s case files and procedures will need initial training followed by close supervision and monitoring until it is clear that information is being entered appropriately and accurately. Periodic verifications are recommended to ensure the quality of data entry.
Security and Networking
The MIS opens in a secure mode, with the database window hidden and menus partially hidden.  Changes to the basic structure and design are relatively easy to make, however, and the ability to do so should be limited to the database administrator or other designated staff.

There are two methods used in Access to protect a database: (1) set a single password for opening the database, or (2) establish user-level security, which limits access to different parts of the database to different users. Setting a single password is the simplest method; it requires each MIS user to type in the same password to open the database. Lost passwords cannot be recovered, so the password should be recorded in a secure place.  The user-level security method, although a bit more time consuming to establish, can be used to prevent users from accidentally damaging the structure of the database.  More information on these methods may be found on the Access Help Menu by typing in “secure a database.”

The Juvenile Drug Court MIS 2002 is intended for use within the drug court itself, and is not designed to link to, or electronically exchange information with, other agencies such as treatment programs and probation departments.  However, if you have multiple computers networked within the drug court office, more than one person may use the MIS at the same time.  Adding, changing, and deleting information from juvenile records in this situation is simple – by default, Microsoft Access will save changes you make to one record when you move to another juvenile’s record (there is no need to click the Save icon on the toolbar).  Within a few seconds, Microsoft Access will also “synchronize” the information. That is, the changes will appear on every open version of the MIS. 

The user-level security method allows you to assign passwords to different users and limit their access or the ability to enter or change data.  Unless you have experience with the maintenance of a multi-user environment, you may want to seek professional assistance in installing the MIS on a network. There are specific decisions to be made prior to the installation regarding user access, editing data, and editing database objects. 

Backups 

As with any database or computer file, you should back up the MIS often to avoid the loss of information due to computer or power failures. The MIS may be saved in compacted or compressed form to save space. Compact your database frequently, especially after making changes to the structure or entering and deleting data.  As the database file will exceed the size of a floppy disk, you must use Microsoft Backup or backup software to copy the file onto more than one disk, or copy the entire MIS using a Zip drive or CD burner. While data are saved automatically as they are entered, we cannot stress enough the need for frequent backups.  Please backup your MIS at least daily.

If You Need Assistance 

Assistance in installing the MIS on your computer, using Access, or making changes to the MIS must be obtained from your court’s computer department. If you have specific questions regarding the use of the MIS, please contact Kristin Guertin at kguertin@redshift.com.

GETTING STARTED

Loading the MIS 2002 

The Juvenile Drug Court MIS 2002 is a database built with Microsoft Access 97, and thus cannot be installed by "Adding software" or running a program through Windows. Please note that the MIS cannot be read or used directly from the CD. The MIS is fully functional only after it is copied onto your hard drive and after you remove the check mark from “Read only” in the Properties dialog box (as described in step eight below). To begin, copy the MIS database from the CD to your computer:

1. Insert the MIS CD.

2. Open Windows Explorer.

3. Double-click on your CD-ROM drive letter.

4. Highlight (click once) the folder titled Juvenile Drug Court Toolkit, right click the mouse, and choose Copy.

5. Highlight the c:/ drive (or a folder you choose within the c:/ drive), right click the mouse, and choose Paste. Alternatively, you may simply click and drag the MIS from your CD-ROM drive to your hard drive in the same way you may move word processing documents.

6. In your c:/ drive, open the folder you’ve just copied. There are three items in the folder: the MIS 2002 (an Access database), the MIS 2002 sample data, and the Self-Evaluation Toolkit for Juvenile Drug Courts (a Word document). 

7. Highlight (click on once) the words MIS 2002, right click on the mouse, and choose Properties.

8. In the Properties dialog box remove the check mark from “Read-only” and click Apply.  

9. Click OK. Repeat this process for any Word document you wish to alter. 

10. Open the MIS you copied into the c:/ drive by clicking on it twice. If the MIS does not open, repeat steps 2 –9. (Note: If Access 2000 is installed on your computer, a message will appear asking if you want to convert the MIS to Access 2000. Although the MIS was developed on Access 97, it will also operate after being converted to Access 2000.)

11. Remove the MIS CD.



The Main Menu  

Upon opening the MIS 2002, the Main Menu appears, displaying all possible options. The first option, Enter, View and Edit Records, leads you to the form used for entering new cases into the MIS, editing data, and viewing data. The second option, Exit Access, closes both the database and Microsoft Access. All other options allow you to print reports. Note that the menu titles appear at the top left corner of the screen, following the words “Microsoft Access.”

Personalizing Your MIS  

You will want to change the current name of the database, “JRC Juvenile Drug Court, Pacific Grove, CA” (found on the upper left of the opening menu), to the name and location of your drug court. Instructions for personalizing your MIS are included in the section of this manual titled Customizing the MIS: For Administrator Use Only. 

ENTERING AND VIEWING CLIENT DATA

Entering New Cases
The Enter, View and Edit Records form is used for entering new cases into the MIS, editing data and viewing data. Upon opening this form, the user will see two rows of “buttons” near the top of the screen. By clicking once on a button, the information displayed on that “page” comes to the front of the screen. The seven buttons on the top row (General Info, Family, Drug Use, Treatment History, Health, Delinquency, Assessment Results) are related to intake information. The first five buttons on the bottom row (Court, Court Dates, Progress and Compliance, Treatment/Services, Outcome) are related to case management information, and the last button (Follow-up) displays a page used to capture post-graduation or termination information on each participant.

The Form is designed so the user may tab through from the first field on a page to the last field on a page. To tab out of a subform (if you keep pressing tab but are not moving on, you are probably in a subform) to the next field, press Ctl + Tab. You will encounter a number of fields with built-in answers on drop-down menus. Use these built-in answers whenever possible to ensure accurate reporting. If the built-in answers are not adequate for your needs you can either (1) type a different answer into the field, or (2) change the built-in answers. Instructions for customizing drop-down menus and setting a default value for a field can be found in the section of this manual titled: Customizing the MIS: For Administrator Use Only.

Follow these steps to enter a new record into the database:

1. Choose Enter, View and Edit Records from the Main Menu.

2. The cursor will automatically appear in the CASE NUMBER field on the page labeled General Info. Type the participant’s case number (assigned by your court) into this field. 



Important: this field must be filled in for the system to operate properly.

3. Continue to tab through the page and enter information. When you reach the last field on the General Info page (Attorney Phone), move to the next page by clicking the button labeled Family. Continue to work through each page in this manner.

4. To obtain a blank record to input another case, click the New Record button on the toolbar.

You may notice that some fields appear more than once, such as current phase and current status. When you enter data (or make changes to the data) in one of these fields, the same data appears in each copy of the field.  The only fields you cannot enter data into are the case number and name fields at the very top of the Enter, View and Edit Records form.

Following is a brief description of each page of the MIS:

General Info

Records juvenile’s name, case #, social security number, demographic information, employment and school status and contacts, attorney name and contact information, and whether the juvenile was previously enrolled in drug treatment court.

Family

Records the names and addresses of primary and secondary parents and/or guardians, and information about them including employment, home and work contacts, custody/living arrangements, other children, CPS status, and whether the parents/guardians are incarcerated.

Drug Use

Records the juvenile’s history of involvement with drugs: for each drug, when use began, frequency of use, last use, route (IV, oral, etc.), and withdrawal and overdose experience. Also has fields for primary and secondary drugs of choice.

Treatment History

For each prior treatment attempt, the MIS can record the name and phone number of the treatment provider, the type and length of treatment, the end date, and the outcome.

Health

Includes descriptions of general and mental health needs, medication, children of the juvenile, current pregnancy, prenatal care, insurance, and a check list indicating suicidal or violent tendencies, and history of physical or sexual abuse.

Delinquency

Records the name of the referring court, judge and date, pending cases, number of times in juvenile hall, and all current charges.

Assessment Results

Records the date of the intake assessment and who completed it, whether the juvenile was found eligible for drug court, whether the juvenile was admitted to drug court, the reason for rejection, and room for notes and comments.

Court

Records the dates of entry into each phase, date of graduation, date the juvenile completes aftercare, date of discharge from drug court, current phase and status, 12-step requirement and 12-step sponsorship.

Court Dates

A subform on this page records information on each court date and phase, whether juvenile complied with his or her contract since the last court date (NA/AA, counseling, drug testing, probation, school, service, other), notes on progress since last court date, recommendations to the judge, whether the juvenile and guardian appeared, arrests and convictions, and sanctions. 

If you wish to use the Court Dates page to produce progress reports for court appearances, you must fill in some fields on this page, and other pages, prior to the court date. See Status Report for Court on page 20 for more information.

Progress and Compliance

Use this page to record multiple case notes, contacts, and drug test results. For each subform entry, record a date, the type of entry (telephone contact, school contact, drug test, case notes, etc.), drug test results, comments, and the initials of the staff member who entered the information. To view the entries by category, choose one of the buttons on the right side of the page. For example, to see all entries that involved a drug test, click on the Drug Tests button. 

Treatment/Services

A subform on this page records multiple current treatment attempts, including the type of treatment (out-patient, residential, etc.), the name of the provider, contact information, current status (enrolled-in compliance, enrolled-not in compliance, on waiting list, etc.), and start and end dates.

Outcome

Includes copies of select fields from the Court page (current status, and graduation, aftercare completion and discharge dates), reason for discharge, whether the birth of a drug-free baby occurred while the juvenile was enrolled in drug court, employment status at graduation, whether the juvenile completed a GED or vocational training during drug court, and an area for comments or notes.

Follow-up

A subform allows you to record multiple follow-up dates, for one juvenile, and covers the following topics: employment, education and school status, treatment, sobriety, and charges.

Repeat Enrollments

When a juvenile enrolls in Drug Court a second time, create a second “file” for him in the MIS. However, if the Case Number your court uses to identify the juvenile is a number that remains with this juvenile throughout youth, and was used to identify the juvenile in the MIS when he was previously enrolled in drug court, you cannot use the same number in the MIS again. We recommend that you use the original case number, adding a “2” at the end. For example, if John Smith entered drug court with the case number “jsmith”, but was terminated from the drug court program and enrolled again 10 months later, enter John Smith into the MIS with the Case Number “jsmith2”.
Using Subforms
Embedded in the Enter, View and Edit Records form are subforms that record multiple data, on one topic, for one participant. On the Treatment History page, for example, you can record all prior treatment attempts by one participant, including the type of treatment, agency name and phone number, length of treatment, end date, and outcome.

Other subforms are found on the Delinquency page (records current charges), the Court Dates page (records information on all court dates), the Progress and Compliance page (records all types of progress and contacts), and the Treatment/Services page (records all current treatment attempts). In addition, a Recommendations subform is embedded in the Court Dates subform, allowing you to record multiple recommendations to the court, for one participant, for one court date.

The Follow-up page contains a subform that records multiple interviews, for one participant, at specified intervals after the participant leaves drug court. Embedded within the follow-up subform is an arrests subform, which can record multiple arrests reported to the interviewer on one interview date (or record multiple arrests extracted from the juvenile’s records for a specific period of time following graduation or termination). 

To move among records within a subform, use the record numbers at the bottom left of the subform. These allow you to move through one record at a time, go directly to the first record, or go directly to the last record. These record numbers are separate from the record numbers at the bottom left of the screen, which are used to move among case records (for example, from Jose Barreras to Karen Crowley, etc.).

Navigation

To move among individual case records, you may use the record selector at the bottom left of each screen, and either click through records one by one, move directly to the first case, or move directly to the last case. A more efficient way of locating a record is to place the cursor in the Case Number field or Last Name field, click the binoculars on the toolbar, and type in the case number or last name you are looking for in the box titled Find What. In the same way, you may find specific contents of any field (say the city of Denver), by placing the cursor in that field (in this case, City), clicking the binoculars, and typing in Denver. 

Sorting Data 

To sort MIS records quickly by last name (or first name), place the cursor in the field labeled Last Name on the Enter, View and Edit Records form and press the button labeled A=>Z, or the button labeled Z=>A, on the toolbar.

PREPARING AND PRINTING REPORTS

The MIS contains nine built-in reports that summarize and print case file information. The reports may be used for day-to-day case management, preparing for court dates, and providing statistics for routine reporting, mandatory DCPO reporting, and evaluation of the drug treatment court program. 

Participant Contact List
This report produces a list, in alphabetical order, of all current participants (those who are marked as admitted, but not discharged, at the time you generate the report). Included on the report are full names of participants, case numbers, dates of intake, and primary guardian and other guardian addresses and telephone numbers. 

The following fields must be kept current for this report to be accurate:


PAGE



FIELD

General Info


First and Last Name


Family



Primary/other guardian names, addresses, and    phone numbers



Assessment Results

Date of assessment






Admitted to drug court?


Outcome


Drug treatment court discharge date

To produce a Participant Contact List:

1.     On the Main Menu, select Participant Contact List.

2.     With the report on screen, choose either Print Report, or Return to Menu (without

           printing). 

Contact List for all Current Juvenile Drug Treatment Court Participants

(Includes those marked as admitted but not discharged at the time of printing)

Name, Case#, Date Admitted     Primary Guardian(s)/Residence       Primary Phone Numbers              Other Guardian(s)/Residence     Other Phone Numbers


1.  Dublin, Sarah E
           Dory Andrewson

              W: (831) 455-5464   x
   
Dorothy DeClue

           W: 

       x 

     J54874


   



W:                            x




           W:

       x

     09/16/2001

           321 Springer Circle

              H:  (831) 455-5464  
   
2134 Jordan St. Apt. 54
           H: (831) 225-4651




           Marina, CA  93933





   
Salinas, CA 93905

2. Fields, Jennifer R
           Matthew Parker

              W:                           x




           W:

      x

    J23238

           June Parker

              W: (831) 233-4353  x 3




           W:

      x

    06/05/2000

           222 Milton Ave. #21 B

H:  (831) 655-4576  




           H:




           Monterey, CA 94905

3. Hargis, Mark

           Pete Hargis

              W:                           x




           W:

      x

    J31245
                         Joy Hargis


              W: (831) 254-8786  x 21




           W:

      x

    03/05/2001

           187 Bruce Street

              H:  (831) 584-5642




           H:




           Seaside, CA 93955

4. Miller, Jeffrey O
           Harriet Under

              W: (831) 384-5842  x 12
  
 Kelly Miller

           W: 

      x

    J45467


   

                            W:                          x




           W:

      x

    08/12/2001

           45 Second Street

              H:  (831) 244-8484
   
321 Kennedy St. #3
           H: (543) 981-2980




           Salinas, CA 93943





   
Molinero, NM 39472

5. Ruelas, Jorge

           Manilla Ruelas

              W: 

    x
   
Pedro Ruelas

           W: 

      x

    J74858


   


              W:

    x
   



           W:

      x

    10/12/2001

           327 First St. Apt. 6D
              H:  (831) 249-8725
   
Lives in Mexico

           H:




           Salinas, CA 93955

6. Smith, George D
           Richard Smith

              W: (831) 655-9000 x 21
   
Fred Smith

           W:

      x

    J58465

           Sally Smith

              W: (831) 384-5521 x 1444
   
Trudy Smith

           W:

      x

    01/05/2001

           3421 Mackaw Street
              H:  (831) 884-7834
    
59 Broadway Ave.
           H:  (831) 855-4562




           Seaside, CA 93955





   
Seaside, CA 93955


Treatment Contact Sheet

Used to identify which juveniles are enrolled with which treatment providers, the Treatment Contact Sheet can be produced for all participants currently in treatment. Sorted first by treatment provider, and second by the branch of the provider, the report also lists each provider contact person and phone number. Following provider information is a list of all juveniles currently enrolled with that provider, including dates of admission to drug treatment court, current phases, and primary guardian names and phone numbers. Each report also includes a space for note taking.

The following fields must be kept current for this report to be accurate:


PAGE



FIELD

Family



Primary guardian names and phone numbers



Assessment Results

Date of assessment






Admitted to drug court?


Court



Current status






Current phase


Treatment/Services

For each treatment listed:





Status






Contact person






Provider






Main office telephone #






Branch






Branch telephone #


Outcome


Drug treatment court discharge date

To produce a Treatment Contact Sheet for all current participants: 

1. On the Main Menu, select Treatment Contact Sheet.

2. With a report on screen, choose either Print Report, or Return to Menu (without printing).

Juvenile Drug Treatment Court Participants in Treatment

Printed on 04/10/2002






Treatment 

Participant, Admission



Guardian Phone

Treatment Provider


Phone Numbers

to DTC, Phase

  Primary Guardian(s)
Numbers

 Notes

Dr. Frink



(831) 578-4564  x 2

 Branch:




            x
              Jeffrey O Miller

  Harriet Under

W: (831) 384-5842  x12

 Contact:






08/12/2001




W:

    x

 Status:    enrolled-in compliance




Phase 1





H:  (831) 244-8484

Dr. Gory



(831) 546-4540  x 



 Branch:



                          x
Mark Hargis

   Pete Hargis

W:

   x

 Contact: 






03/05/2001

   Joy Hargis

W: (831) 254-8786  x21

 Status:    enrolled-in compliance




Phase 2





H:  (831) 584-5642

Dr. Vera



(831) 582-4564  x 2


 Branch:




            x 
George D Smith

   Richard Smith

W: (831) 655-9000 x21

 Contact:   Dr. Vera





01/05/2001

   Sally Smith

W: (831) 384-5521 x1444

 Status:    enrolled-in compliance




Phase 3





H:  (831) 884-7834

Exodus House



(831) 456-7894  x45

 Branch:




            x
              George D Smith

   Richard Smith

W: (831) 655-9000 x21

 Contact:   






01/05/2001

   Sally Smith

W: (831) 384-5521 x1444

 Status:    referred-not yet enrolled




Phase 3





H:  (831) 884-7834

Start Anew



(831) 552-1000  x

 Branch:




            x
              Jennifer R Fields

   Matthew Parker

W:

   x

 Contact:






06/05/2000

   June Parker

W: (831) 233-4353 x3

 Status:    enrolled-in compliance




Phase 2





H:  (831) 655-4576

 Branch:




            x
              Jorge Ruelas

   Manilla Ruelas

W:

   x

 Contact:  Mary Cuevas





10/12/2001




W:

   x

 Status: enrolled-in compliance




Phase 1





H:  (831) 249-8725

Individual Progress Report

This report presents a summary of an individual’s current status in drug court, including an overview of his or her progress as measured by urinalysis results, court appearances, and sanctions applied.

The following fields must be kept current for this report to be accurate:


PAGE



FIELD

Assessment Results

Date of assessment






Admitted to drug court?


Court



Current phase






Current status


Court Dates


For each court date listed:
Court date






Juvenile appeared






Guardian appeared






Bench warrant issued today






Bench warrant issued > 60 days and not picked up






Has been arrested/convicted of crime






Sanction(s)


Progress and Compliance
For each progress and compliance entry:
Date






Drug test (check box)






Submitted






Tox






Drugs present






Sent to lab

To produce an Individual Progress Report for one participant:

1. On the Main Menu, choose Individual Progress Report.

2. A prompt will appear asking for a Case Number. Type in the case number of the person whose report you want to produce. Click OK.

3. With the report on screen, choose Print Report, or Return to Menu (without printing).

Individual Progress Report

Juvenile Drug Treatment Court

NAME
Dublin, Sarah E
Date entered phase 1 
09/16/2001


Case number
J54874
Date entered phase 2


Date of birth
08/02/1987
Date entered phase 3



Drug Court assessment   09/16/2001
Date entered aftercare 
02/01/2001

Current Status
active, in program
12-step requirement
2x/week

COURT DATES

   Court       Juvenile 
Parent       BW     BW>60     Arrested/

   Dates       Present
Present
   issued    days       Convicted
 Sanction 1           Sanction 2            Sanction 3


09/20/2001    yes
  yes
 





09/27/2001    yes           yes
 



  demerits


10/04/2001 

URINALYSIS RESULTS


Date

Submitted?

Tox

Sent to lab?

Drugs Present


09/15/2001        no-show


9/16/2001             yes


 neg




None

Wednesday, April 10, 2002 11:57 AM

          Page 1 of 1

Individual Progress and Compliance Reports

This report was designed to print out summaries of all entries, for one individual and by category or all together, made on the Progress and Compliance page.

The following fields must be kept current for this report to be accurate:


PAGE



FIELD

Progress and Compliance
For each entry:







Date






Current phase






Check all boxes (categories) that apply






Urinalysis information, if applicable






Any case notes or comments






Staff initials, if desired

To produce a Progress and Compliance Report for one participant:

1. On the Main Menu, click the button labeled Individual Progress and Compliance Reports.

2. Choose (click) a category. At the prompt, type in a case number, and click OK. The report will print.

Summary of Drug Tests

Progress and Compliance Report

      Name

     Ruelas, Jorge

      Case number
     J74858





        All contacts and notes

        Date, Phase    
Urinalysis               recorded for this entry            
Comments/Notes


10/16/2001          Submitted:   yes
            Telephone       School
          
Minor admitted smoking marijuana on

Phase 1 
Tox:            pos
            Drug test         JH/Jail
          
10/15/01.  He should test clean by 11/15/01.

Staff: EMS       
Sent to lab:  no
            Office visit      Employment

Drugs present: THC         Home visit      Notes



                           Treatment      Other

10/23/2001       
Submitted:   yes
             Telephone      School
       
Minor should test clean by 11/15/01.  He has 

Phase 1
Tox:            pos
             Drug test        JH/Jail
           
enrolled in Start Anew and is doing much better.  

Staff: EMS    
Sent to lab:  no
             Office visit     Employment

Drugs present: THC         Home visit      Notes



                          Treatment       Other

         Wednesday, April 10, 2002
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J74858

Status Report for Court 

The Status Report was designed to help coordinators prepare for court by gathering and presenting information on the progress of each juvenile since his or her last court appearance. The top section of the report includes general information such as case number, status, current phase and intake date, and the number of positive drug tests in phases one, two and three (calculated from drug test information entered on the Progress and Compliance page). This is followed by the provider name and status of all treatment programs the juvenile is referred to or enrolled in, whether or not the juvenile complied with his or her contract since the last court date, notes on the juvenile’s progress since the last court date, and specific recommendations to the court. Information on the latter three, compliance with contract, progress notes and recommendations, are taken directly from the Court Dates page. When you run this report, you will be prompted for a court date. A report for every juvenile scheduled to appear on that court date will appear on your screen.

The following fields must be kept current for this report to be accurate:


PAGE



FIELD

General Info


Case number






First name






Middle initial






Last name


Assessment Results

Admitted to drug court?


Court



Current phase






Current status






Date entered phase 1






Date entered phase 2






Date entered phase 3






Date entered aftercare


Court Dates


Court date






Complied with contract (entire section)






Progress since last court date






Recommendations


Progress and Compliance
Date






Current phase






Drug test (check box)






Tox


Treatment/Services

Provider






Status

To produce the Status Report for Court:

1. Make a new entry under Court Dates for each juvenile scheduled to appear in court the following day (or however many days you prepare in advance). Fill in the court date, current phase, whether or not they complied with the conditions of their contract, write notes related to those conditions, summarize progress made since the last court appearance, and list specific recommendations. All Complied with Contract headings (such as NA/AA, Counseling, etc.) appear on the report. You have the option of choosing “yes”, “no”, or “N/A” to indicate if the juvenile complied (or was asked to comply) with these conditions. Someone with intermediate Access skills could easily alter these headings as they appear on both the Court Date page and the Status Report. You could, for example, change “other” to “journal” or “curfew”.

The remaining fields on the Court Date page are filled in after the juvenile has 

Appeared (or has failed to appear) in court.

2. Using the Treatment Contact List (after verifying treatment status), update the Treatment/Services page of each juvenile. (See instructions under Treatment Contact List on page 23).

3. On the Main Menu, click the button labeled Status Report for Court.

4. At the prompt, type in the upcoming court date and click OK.

5. One report for each juvenile scheduled to appear in court on the day you indicated will appear on screen. You can browse through the reports one by one using the arrows at the bottom left corner of the screen.

6. With the report on screen, choose either Print Report, or Return to Menu (without printing).

                           Status Report for Court Date 10/25/2001

JUVENILE DRUG TREATMENT COURT

PRINTED ON 04/10/2002

NAME
     Ruelas, Jorge            
ASSESSMENT DATE       10/12/2001  
#PHASE 1 POS. TESTS   2

CASE #     J74858                           
ENTERED PHASE 1         10/12/2001   
#PHASE 2 POS. TESTS

STATUS    active, in program          
ENTERED PHASE 2                             
#PHASE 3 POS. TESTS

PHASE      Phase 1

       
ENTERED PHASE 3





     
ENTERED AFTERCARE   04/24/2001

TREATMENT STATUS

       PROGRAM


 

STATUS

       Start Anew



      
enrolled-in compliance

COMPLIED WITH CONTRACT

      CONDITION


YES/NO      
NOTES

      NA/AA


  yes
       
Start Anew program

      Counseling

               yes
       
Start Anew-Dr. Mary Cuevas

      Drug Testing

  yes
       
Pos. THC 10/23/01 (should be clean by 11/15/01)

      Probation


  yes
       
Program visit 10/23/01

      School

 
  yes
     
Start Anew

      Community Service

  n/a

      Other


  n/a

PROGRESS

     The minor is doing considerably better since his last Court Review.  Since enrolling in Start Anew, Jorge

     is getting one on one counseling plus small group NA/AA meetings with sole Spanish speakers.  He is also

     attending classes with Start Anew to learn English.

RECOMMENDATIONS


         Program Coordinator


Date

Treatment Contact Sheet (query by court date)

Identical in format to the other Treatment Contact Sheet, this report lists those participants appearing on a court date defined by the user, and can be used to verify treatment progress prior to court appearances. Sorted first by treatment provider, and second by the branch of the provider, the report also lists each provider contact person and phone number. Following provider information is a list of all juveniles currently enrolled with that provider, including dates of admission to drug treatment court, current phases, and primary guardian names and phone numbers. Each report also includes a space for taking notes while verifying progress and compliance on the telephone with treatment providers.

The following fields must be kept current for this report to be accurate:


PAGE



FIELD

Assessment Results

Date of assessment






Admitted to drug court?


Court



Current status






Current phase


Treatment/Services

For each treatment listed:





Status






Contact person






Provider






Main office telephone #






Branch






Branch telephone #


Outcome


Date discharged from DTC

To produce a Treatment Contact Sheet for an upcoming court date:

1. For each individual who will appear in court on this date, create a new record for the upcoming court date on the Court Dates page. You may have done this already while preparing the Status Report for Court (see step 1 under Status Report for Court on page 20). If not, go to the Court Dates page for each juvenile, create a new record by clicking the New Records button on the toolbar, and enter the date into the Court Date field. 

2. On the Main Menu, select Treatment Contact Sheet (query by court date).

3. With a report on screen, choose either Print Report, or Return to Menu (without printing). 

Juvenile Drug Treatment Court Participants in Treatment

Printed on 04/10/2002 for court date 3/6/01




                   Treatment

     Participant, Admission


          Guardian Phone

Treatment Provider
                   Phone Numbers
     to DTC, Phase
         Primary Guardian(s)     Numbers
                      Notes


Dr. Gory

                  (831) 546-4540  x

  Branch:


                               x       
Mark Hargis


Pete Hargis
W:                           x  

  Contact:




              
03/05/2001

     
Joy Hargis
W: (831) 254-8786 x 21

  Status:    enrolled-in compliance

              
Phase 2




H:  (831) 584-5642

Dr. Vera


     (831) 582-4564 x 2



  Branch:




     x
George D Smith                Richard Smith
         W: (831) 655-9000 x 21

  Contact: Dr. Vera




01/05/2001

Caseload Statistics

The Caseload Statistics report produces a set of statistics for a period of time specified by the user. The first section of the report shows the number of juveniles in drug court during this time, how many were promoted to phase 2 and phase 3, and how many passed through phase 1, 2, 3 and aftercare. Because more than one juvenile could be in more than one phase during the time specified, the total number of juveniles in phases 1, 2, 3, and aftercare will not equal the number of juveniles enrolled in drug court. The remaining sections of the report provide information on referrals, assessments and admission to the drug court program, drug testing, the number of juveniles enrolled in different types of treatment, and the status of all juveniles who left the program (graduations, terminations, voluntary withdrawals, and deaths).

The following fields must be kept up-to-date for your report to be accurate:


PAGE



FIELD

General Info


Case number






Gender


Delinquency


Referral Date


Assessment Results

Date of assessment






Admitted to drug court?






If rejected, why?


Court



Date entered phase 1






Date entered phase 2






Date entered phase 3






Date entered aftercare






Graduation date


Progress and Compliance
For each progress and compliance entry:





Date






Drug test (check box)






Tox






Sent to lab


Treatment/Services

For each treatment listed:





Type






Status






Start date






End date (if applicable)


Outcome


Drug treatment court discharge date






Current status/reason for discharge

To produce the Caseload Statistics report:

1. On the Main Menu, click the button labeled Caseload Statistics. 

2. You will be prompted for a beginning date and an ending date. Type in the beginning date and click OK. Type in the ending date and click OK.

3. With the report on screen, choose either Print Report, or click or Return to Menu (without printing).

Juvenile Drug Treatment Court

Caseload Statistics

Data from 1/01/01 to 7/01/01
Status of juveniles enrolled in drug treatment court


Juveniles enrolled in drug court
4


Promoted to phase 2


0


Promoted to phase 3


2


In phase 1



0


In phase 2



4


In phase 3



2


In aftercare



3

Referrals and Assessments



Treatment


New referrals



2

     12-step program


1


Assessments completed

2

     Aftercare



0


Cases admitted to drug court

2

     Anger management

1



Females Admitted

0

     Community service

0



Males Admitted

2

     Counseling



0


Cases rejected


0

     Detox



1



Did not appear

0

     Mental health


0



Ineligible


0

     Residential



0



Not suitable


0







Drug Testing





Discharge


Juveniles tested


3

     Graduated from drug court
0


Total tests performed


7

     Terminated from drug court
0



Negative tests


1

     Voluntarily withdrew 

0



Positive tests


6

     Died while in drug court

0



Tests sent to lab

2


Printed on Wednesday, April 10, 2002

Snapshot Report

The Snapshot Report allows the user to determine the status of all current cases (whether they are active-in the program, active-in custody, or on bench warrant status), the total current caseload (broken down by phase), and the number of participants currently in treatment (broken down by treatment area). All statistics reflect the status of cases at the time report is produced, thus presenting a “snapshot” in time of the current caseload. The number of juveniles in Phase 1, for example, reflects the number of juveniles who are marked in the MIS as being in Phase 1 in the Current phase field at the time the report is produced.

The following fields must be kept up-to-date for your report to be accurate:


PAGE



FIELD

General Info


Case number


Assessment Results

Date of assessment






Admitted to drug court?


Court



Graduation date






Current phase






Current status


Treatment/Services

Type






Status


Outcome


Drug treatment court discharge date

To produce a Snapshot Report:

1. On the Main Menu, click the button labeled Snapshot Report.

2. With the report on screen, choose either Print Report, or click or Return to Menu (without printing).

SNAPSHOT REPORT

Status of all cases at the time of printing

     Juvenile Drug Treatment Court

CURRENT CASELOAD

6

STATUS OF CURRENT TREATMENT

Phase 1



3

12-Step Program



1

Phase 2



2

Aftercare




0

Phase 3



1

Anger Management



1

Aftercare



0

Community Service



1

STATUS OF CURRENT CASES


Counseling




1

Active, in program


4

Detox





1

Active, in custody


1

Mental Health




0

Bench warrant status


1

Residential




1


Printed on Wednesday, April 10, 2002

DCPO Bi-Annual Report
This report is designed to produce information requested on DCPO (Drug Court Program Office) bi-annual surveys, including admissions and discharge information, ages, gender and ethnic descent of juveniles admitted to drug treatment court, bench warrant status while participating in drug treatment court, and outcomes at graduation. 

The following fields must be kept current for this report to be accurate:

PAGE



FIELD
General Info


Case number





Gender





Age





Ethnicity

Assessment Results

Date of assessment






Admitted to drug court?






If rejected, why?


Court



Graduation date






Current status


Court Dates


For each court date entry:






Court date






Bench warrant status > 60 days and not picked up


Outcome


Drug treatment court discharge date






Had drug-free baby while participating in DTC






Date (below drug-free baby field)






Employed at graduation






Earned GED while participating in DTC






Date (below GED field)






Earned vocational training credential while 






participating in DTC






Date (below vocational training field)

To produce the DCPO report:

1. On the Main Menu, click the button labeled DCPO Bi-Annual Report. 

2. You will be prompted for a beginning date and an ending date. Type in the beginning date and click OK. Type in the ending date and click OK.  

3. You will see a print preview of the report. Click either Print Report, or click on Return to Menu (without printing).

Data for the DCPO Grantee Data Collection Survey

For the time period: 1/01/01 to 1/01/02

Admissions and Discharge
  Admitted to the drug treatment court program






5

       Females Admitted









1

       Males Admitted










4

  Completed the drug treatment court program






1

  Terminated










0

  Voluntarily withdrew










0

  Died while in the program









0

Ages of Juveniles Admitted to Program

  Ages 12 to 16










3

  Ages 17 to 18










2

  Ages 19 to 21










0

Ethnic Descent of Juveniles Admitted to Program
  African American










0

  Alaskan Native










0

  Asian or Pacific Islander









0

  Caucasian










2

  Hispanic/Latino










1

  Native American










2

  Other Ethnicities










0

Outcomes

  Earned GED while participating in the drug treatment court program



1

  Earned vocational credential while participating in the drug

  treatment court program









0

  Drug free babies born to participants







1

  Employed at graduation









1

Other
  Bench warrant status for over 60 days and not picked up





CUSTOMIZING THE MIS: FOR ADMINISTRATOR USE ONLY

Introduction

In this section, instructions are given for overriding the built-in security in order to make changes to the database. For this reason, you may want to make this section of the manual unavailable to users.

Built in Security.  To make changes to the structure of the MIS, you must first override built in security.  To do this, open the database while holding down the Shift key.  The MIS will open in Design View, displaying the database window.

Compact the MIS.  For maximum efficiency and speed, you should compact the database on a regular basis (every other week, once a month), and always after making changes to the structure or deleting groups of records. To compact the database: 1) override built in security, and 2) from the drop-down menus at the top of the screen choose Tools => Database Utilities => Compact Database.

Customizing your MIS.  Below, five types of changes for customizing your MIS are described step-by-step. They provide the user with relatively simple ways to tailor the information system to meet local needs.  The five types of customization are:

1. Personalizing the MIS. Place the name and location of your drug court on the Main Menu.

2. Defining a default value for a field. Use default values to ensure accurate reporting and speed up the data entry process. An example of using a default value would be to automatically assign the value “CA” (for California) to the state field on the Enter, View and Edit Records form for every new record.

3. Creating a new or modifying an existing “combo box,” or drop-down menu. Examples of combo boxes or drop-down menus are the choices listed under the Ethnicity and Language fields. 

4. Adding new fields or pages to the Enter, View and Edit Records form. Fields are discrete pieces of information, such as the participant’s First Name, Middle Initial, and Last Name.  Pages refer to a whole screen, such as the Family or Drug Use pages of the Enter, View and Edit Records Form.

5. Creating a new or modifying an existing subform. Subforms refer to forms within forms that enable you to enter multiple pieces of like information -- such as information on each child of the participant or all prior treatment attempts.

Before reading the customization instructions, please review the following key definitions and instructions.

Key Definitions and Instructions
Database window.  The Database Window automatically appears on screen when you open the MIS while holding down the Shift key. If you “lose” this window while working in the non-secure mode, press F11 to bring it to the front of the screen. The Database window provides the user with options for viewing and manipulating database objects, the underlying structures, and design of the MIS. Database objects include tables, queries, forms, reports, macros, and modules. Do not close the database window unless you are finished with the MIS. Closing the database window closes the database.

Forms vs. subforms.  A form is used for entering information into a database, and to view data already entered. A subform is a form within a form. A user can work with a form or subform in both Form View and Design View.

Form View vs. Design View. Users "view" forms, subforms, and reports in either Form View or Design View.  Form View is used to enter data or to view previously entered data. Design View is used only to make changes to tables, forms, queries, and reports. To open a form in Design View: click the Forms tab on the database window, highlight the name of the form, and click the button labeled Design. To change between Form View and Design View while a form is open on the screen: select Form View or Design View from the drop-down menu on the View button on the toolbar.

Text boxes and fields.  A text box is a box that holds a label for a field on a form. A field is a box into which the user types information. On the Enter, View and Edit Records Form, for example, a text box holds the label First Name. Following the First Name text box is a field that holds the participant’s first name. 

To size and position a text box or field:

1. Go to Design View of the form containing the boxes.

2. Select (highlight) the box by clicking on it once.

3. To move the entire box, place the cursor on the largest black box appearing in the upper right corner of the text/field box. When the cursor turns into a hand, click and drag the box.

4. To size the box, place the cursor over one of the small, black boxes appearing in the middle of each side of the text/field box, and drag the edges out or in.

Data types.  Every field in a table must be assigned a data type. The following definitions of data types are taken from the Access Help Menu:

Data types
Definition
Text

Text or combinations of text and numbers, such as addresses. Also numbers that do not require calculations, such as phone numbers, part numbers, or postal codes. Holds up to 255 characters.

Memo

Lengthy text and numbers, such as notes or descriptions. Holds up to 64,000 characters.

Number
Numeric data to be used for mathematical calculations, except calculations involving money (use Currency type). Set the FieldSize property to define the specific Number type. 1,2,4, or 8 bytes.

Date/Time
Dates and times. 8 bytes.

Currency
Currency values. Use the Currency data type to prevent rounding off during calculations. Accurate to 15 digits to the left of the decimal point and 4 digits to the right. 8 bytes.

AutoNumber
Unique sequential (incrementing by 1) or random numbers automatically inserted when a record is added. 4 bytes.

Yes/No
Fields that will contain only one of two values, such as Yes/No, True/False, On/Off.

More information on these and other, more advanced, data types may be found by clicking on the Office Assistant button on the toolbar and typing in “data type.”

List of Fields. To generate and print a list of all fields in the database, open the MIS while holding down the Shift key. Choose Tools => Analyze => Documenter and click on the tab labeled Tables. Click Select All, and click OK. A list of all fields will appear on screen, organized by table.

Tables. All data you enter into the MIS are stored in tables. Tables, which the general user does not see, are made of fields. You can find out what fields are in a table by either producing a list of fields (see above), or clicking on the “tables” tab on the Database Window, and opening a table in Design View. The MIS contains the following tables:


Table Name

Holds all information typed into….


tblCourt

the Court Dates subform (page), except recommendations


tblCurrentCharges
the Current charges subform on the Delinquency page


tblCurrentTreatment
the Treatment/Services subform (page)


tblFollowUp

the Follow-up subform (page), except follow-up charges


tblFollowUpCharges
the Follow-up charges subform on the Follow-up page


tblMain

all fields not in a subform


tblRecommendations
the Recommendations subform on the Court Dates page


tblTreatmentHistory
the Treatment History subform (page)


tblUrinalysis

the Progress and Compliance subform (page)

Personalize your MIS  

To change the current name of the database to the name of your drug court:

1. Click on the Forms tab of the Database Window. Highlight the word Switchboard on the Forms tab and click the Design button.

2. In Design View of the Switchboard, place cursor inside the box that says JRC Juvenile Drug Court and backspace over these words.

3. Type in the name of your drug court.

4. Place cursor inside the box that says Pacific Grove, CA and backspace over these words.

5. Type in your own city and state.

6. Click Save button on toolbar.

7. Close the Switchboard by clicking on the lower “x” in the upper-right corner of the screen.

Any changes you make to the Main Menu usually appear after you close and re-open the database.

Define a Default Value for a Field

You may specify a default value for any field. If your drug court is in California, for example, you may want "CA" to automatically appear in the State field of all addresses. Setting a default value for a field has no impact on existing data. To set a default value for a field:

1. Determine which table holds the field for which you want to define a default value. See above for instructions on producing a list of all tables and their fields.

2. On the Database Window, click on the tab labeled Tables.

3. Highlight (click once) on the table, and click the button labeled Design on the right side of the screen.

4. In the upper portion of the Design View of the table, click on the name of the field.

5. In the lower portion of the Design View of the table, click the Default Value property box and type in the default value (such as California or CA).

6. Click Save on the toolbar.

7. Close the form by clicking on the lower “x” in the upper-right corner of the screen.

Create or Modify a Combo Box (drop-down menu) 

To create a combo box (or drop-down menu of responses), first:

1. Go to Design View of the form. On the Forms tab of the database window, highlight the name of the form and click the button labeled Design.

2. Click once on the field, right click the mouse, and select Change To => Combo Box.

To create or modify the drop-down list of selections:

3. Double-click on the field to open its Properties box. (Or highlight the field, right click the mouse, and choose Properties.)

4. Under the Data tab, select Value List from the drop-down menu under Row Source Type.

5. Under Row Source on the Data tab type in the drop-down options in the following format: “option A”; “option B”; “option C”. For example: “married”; “separated”; “divorced”; “widowed”, etc.

6. Close the Properties box.

7. Click Save on the toolbar.

8. Go back to Form View to test the new combo box. 

Adding New Fields to the Enter, View and Edit Records Form
First, create the new field in the main table:

1. In the database window, click the tab labeled Tables.

2. Highlight the table named tblMain to add a field to the Enter, View and Edit Records form (but not to a subform within this form).

3. Click the button labeled Design.

4. Scroll down to the end of the list of field names.

5. Type in a name, without spaces, for your new field (you may later alter the name on the form).

6. Enter a data type (See chart on page 31 to determine data type).

7. Click Save on the toolbar and close the table.

Next, place the new field on the form:

8. Click on Forms tab of database window.

9. Highlight the name of the form: frmAddNewRecords.

10. Click the button labeled Design.

11. Click Field List button on toolbar. (Or, choose View from drop-down menus at the top of the screen, and choose Field List.)

12. Scroll down to the bottom of field list.

13. Click on the new field, drag it onto the form, and release the button to place it on the form.

14. Close the Field List box.

15. Label the field by clicking inside the text box.

16. Position and size the new field.

17. Click save button on toolbar.

18. Go to form view to review the changes.
Adding New Pages to the Enter, View and Edit Records Form.
1. Go to Design View of the form labeled frmAddNewRecords:  In the Database Window, highlight the name of the form and click the button labeled Design.

2. Right click the mouse and choose Insert Page.

Name the page:

3. Double-click on the tab to see the Properties box for that page.

4. Under the All tab in the Properties box, type in a name under Name. Type it again under Caption.

5. Close Properties box.

Change the order of pages as they appear on the form:

6. Right click on page and select Page Order form the drop-down menu that appears.

7. Follow the instructions to change the page order for that form.

8. Click OK, click Save on the toolbar, and go back to Form View.

Creating or Altering Subforms
The following directions guide the user through the process of creating a subform in Datasheet View (see the Current Charges subform on the Delinquency page for an example) that is used for inputting and viewing multiple entries on one topic for one participant

Create a subform. First, create a new table for the subform:  

1. Determine the names of your new fields for the subform.

2. In database window, click on Tables tab, and click New button.

3. In New Table box, select Design View and click OK.

4. Type “JuvenileID” in Field name, and choose “Text” from drop-down list in Data Type.

5. Type “(TableName)ID” in Field name on the next line. For example, if your table pertains to the participant’s spouse you would type in “SpouseID.” Choose “Auto Number” from drop-down list in Data Type. 

6. With the cursor still in the box containing the words Auto Number, hold down the control key, and click the row selector for each field. With both rows highlighted, click the Primary Key button on the toolbar. A picture of a key should appear to the left of both field names.

7. Type in new field names and data types.

8. Click the Save button on the toolbar.

9. In Save As box, type in a Table Name and Click OK.

10. Close table.

To connect the new table to the main table:

11. With the database window on screen, click the Relationships button on the toolbar.

12. Click Show Table button on toolbar.

13. Find and highlight name of your new table in Show Table box.

14. Click Add button.

15. Close Show Table box.

16. Click on JuvenileID in box labeled tblMain, drag to the box with the label of your new table, and drop on JuvenileID. A Relationships dialogue box should appear.

17. In the Relationships box, click on Join Type.

18. Click Option 2 and click OK.

19. In the Relationships box, check Enforce Referential Integrity.

20. In the Relationships box at the bottom, the relationship type should be One-To-Many.

21. Click the Create button.

22. Click the Save button on toolbar, and close the relationships window.

Create the new subform:

23. In the Database Window, click on the Forms tab, and highlight the form on which you want to place the new subform. (If you want to place it on one of the pages of the Enter, View and Edit Records form – but not on a subform within this form – highlight tblAddNewRecords.

24. Click the button labeled Design.

25. Click the Toolbox button on the toolbar.

26. Select (click on) Control Wizards button in the Toolbox. (You may need to install the Wizards feature from your Microsoft Access CD.)

27. Click on Subform/Subreport button on toolbox bar.

28. Click on form to place the subform.

29. On the first screen of the Subform/Subreport Wizard, choose Table/Query and click Next.

30. On the second screen of the Subform/Subreport Wizard, select the name of your new table from the drop-down list of tables. Move all fields listed under Available Fields to Selected Fields and click Next.

31. On the third screen of the Subform/Subreport Wizard, choose Define my own. Choose JuvenileID for Form/report fields, choose JuvenileID for Subform/subreport fields, and click Next.

32. On the fourth screen of the Subform/Subreport Wizard, type in a name for the new subform. (Hint: begin with the abbreviation “sbfrm” in the name for easier identification later, and do not use spaces).

33. Click Finish.

Modify the new subform:

34. Double click on subform (appears as a white box) to open it in Design View.

35. Choose Datasheet View from drop-down menu of View button on toolbar. This view will produce a subform in the style of the Current Charges subform on the Delinquency page.

 
[If you would like to create a subform in the style of the subforms on the Treatment History Page or Progress and Compliance page, you need to instead choose Design View from the drop-down menu of the View button on the toolbar. Skip steps 36 – 47, and instead design your subform by placing and labeling fields on the subform. Follow steps 8 – 18 under add a new field to a form on page 34. ]

36. Click on JuvenileID to highlight column.

37. Choose Format => Hide column.

38. Repeat steps 36 and 37 for other “ID” field.

39. Click on a field name (any) to highlight column.

40. Choose Format => Font. Set Font at Arial, Font Style at Regular, and Size at 8.

41. Choose Design View from drop-down menu of view button on toolbar.

42. To change the name of a column heading, highlight (click on) the field under the Detail section, right click the mouse, and choose Properties.

43. In the Properties box under All, type in the column heading as you would like it to appear under the row titled Name.

44. Repeat steps 42 and 43 to change other column headings in the subform.

45. Save and close subform.

46. Go to Form View of form that contains your new subform.

47. Change column size by placing cursor on line between column titles, clicking and dragging.

Alter an existing subform. To remove an existing field, make changes to test, or alter a drop-down menu on a subform:

1. In the Database Window, click Forms, highlight the name of the form (used as a subform) you wish to alter, and click the Design button. A list of all field names can be produced. See page 32. 

2. In Design View, make changes to the form.



Remove a field:  

Select (click on) a field, and choose Edit => Delete.



Add a field: 


Follow instructions on page 34.


Change text:  


Select (click on) a text box, click inside the box, 






and alter the text.


Alter a drop-down menu:  
Follow instructions on page 33.

3. Click the save button, and go to Form View to look over your changes.

Permanently delete the full record of a participant. 

As a precaution, general users cannot permanently delete participants from the MIS without taking the time and effort to prepare the system to accept deletions:

1. Open the database while holding down the Shift key to override the built-in security.

2. Choose Tools, then Relationships.

3. In the Relationships window, double click on the black line connecting tblMain and tblFamily. Check the box titled Cascade Delete Related Records. Click OK.  Repeat this process for every other relationship (boxes connected by black lines).

4. Click Save.

To delete the full record of a participant:

1. Place the cursor in the Case Number field (on the Enter, View and Edit Records Form) of the participant whose record you want to delete.

2. Click on the Delete Record button on the toolbar, or choose Edit => Delete Record from the drop-down menu.

3. Microsoft Access will ask if you are sure you want to delete the record of this participant.  Click Yes to permanently delete the record; click No to restore and save the record.

4. Compact the database.  Tools => Database Utilities => Compact Database.

After the deletions have been made, you will need to return to the Relationships window to uncheck all the boxes labeled Cascade Delete Related Records.  This step is necessary only if you decide to maintain this extra level of security.


